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Abstract 

The abstract should be around 200 words and should contain the essence of the 

dissertation but should not refer to the main body of the dissertation. Below is a sample 

abstract: 

In viewing the self-organizing capacity of an organization as a complex interacting web of 

knowledge and behaviour, which is subject to instability and constant dynamism, this 

article considers the use of an action science approach to the multifarious interactions 

which have underpinned the conception and delivery of a senior management 

development program for a healthcare group of six hospitals and 94 pharmacies in the 

UAE. The article reviews the application of the action modalities of action learning and 

action science within the epistemological development and selection of the program 

pedagogy, the locus of which has been derived from the European Foundation for Quality 

Management Excellence Model concepts of excellence. The initial scoping interviews 

held with the strategic directorate are reviewed and triangulated against the views of the 

senior management delegate cohort and the academic development team. In seeking 

evidence of adaptive change, the position before and after the management development 

program delivery was additionally determined. 

Keywords:  action learning; action science; management development; international 

healthcare; EFQM 
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Below is an example of a Table of Contents, generated for this template.  Note that the 

section headings have been numbered and assigned a page number.  The list of contents 

will help the reader navigate their way around the report.  In MS-Word use the style tool 

on the right hand side of the Home ribbon when entering Chapter Headings; this will 

enable you to generate a Table of Contents under the References tab.   

In this example chapter and section titles are numbered – this layout makes larger 

documents easy to navigate, but it is not a requirement, i.e. you do not need to number 

your chapters.  Obviously, your individual chapter headings will be specific to your 

research and vary from those in the example.  
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List of Tables (use if needed – otherwise delete). 

Tables can be very effective for summarizing large bodies of material.  If you use tables 

they should be listed here.  Where only a small number of tables is used, then the list 

could be combined with the list of figures on the next page, i.e. use a combined title: 

List of Figures and Tables 

Figures and tables should, where possible, be integrated into the text.  All figures and 

tables must be numbered.  Tables are numbered separately from figures.  For example, 

using the numerical system, Table 4.1 would be the first table cited in chapter 4; Figure 

4.1 would be the first figure cited in chapter 4.  Figures include all graphs diagrams, charts 

and images.  Tables are considered and numbered separately from figures.  In all cases, 

an explanatory title should be provided next to the figure or table number (again, in MS-

Word, use the insert caption option (found under the References tab) to do this and 

automatically generate a List of Tables.  For example: 
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Abbreviations (use if needed – otherwise delete) 

If you use a lot of abbreviations or acronyms in your dissertation it can be useful to list 

them.  Ensure that they are listed in alphabetical order.   

EU  European Union 

GCC  Gulf Cooperation Council 

GDP   Gross Domestic Product 

KSA  Kingdom of Saudi Arabia 

MENA  Middle East and North Africa 

OLS  Ordinary Least Squares 

UAE  United Arab Emirates 
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Chapter 1: (insert chapter title) 

The word limit for an MBRSG Masters dissertation is 15,000 words.  This refers to the 

body of the text, i.e. it excludes the reference list and any appendixes.  If your dissertation 

is much shorter than 15,000 words it suggests that more detail, relevant information or 

explanation may be required; if it is much longer it suggest that you have been overly 

descriptive or that unrelated material is included.  Subsequently MBRSG will allow a 

tolerance of no more than plus or minus 10% in length. 

For the body of the dissertation you can use Arial, Times New Roman, or Dubai font. 

Use a 12 pt. font and 1.5-line spacing.  These instructions are in Arial.  Ensure you start 

each chapter on a new page and do not leave section headings floating at the bottom of 

a page.  As noted above, all tables and figures should be labelled, numbered and closely 

integrated with the text. 

The first chapter of your dissertation should introduce and motivate your topic.  It will 

guide the reader by describing what your dissertation does.  Typically, the introduction 

includes the following: 

A background section that briefly explains and introduces the subject of your investigation 

provides relevant context given your degree. 

The study aims and objectives or research questions, i.e. it should include a clear and 

precise statement of the aims of your project as well as the objectives – the objectives 

can be stated in the form of research questions.  Note that research questions are 

equivalent to objectives, therefore, you cannot state both objectives and research 

questions.  Make sure that the objectives or the research questions contribute directly to 

achieving the study aim. 

If you are conducting an empirical study this chapter should include the research 

hypotheses 

Conclude the chapter with an outline of the way your report is structured, i.e. describe 

what each chapter sets out to do. 
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Chapter 2: (insert chapter title) 

The second chapter is generally a literature review.  A good literature review will: 

 provide detailed context for the research, including theory 

 provide justification for the research 

 ensure the research has not been undertaken before (or if it is repeated, that it is 

marked as a "replication study") 

 demonstrate where the research fits into the existing body of knowledge 

 enable the researcher to learn from previous investigation on the subject 

 illustrate how the subject has been studied previously 

 highlight flaws or gaps in previous research 

 demonstrate that the work is adding to the understanding and knowledge of the 

field 

 help refine, refocus or re-orientate the topic 

This chapter is a crucial component of your dissertation and you should critically evaluate 

the literature (arguments and reliability of different sources) and create a coherent 

sequence of arguments from the themes drawn from the literature. 

It is a good idea to introduce the chapter by outlining what the chapter covers; this could 

include relevant definitions, related actors, legislation, and policy. 

It is important to summarise the chapter to highlight what we know about the subject of 

your dissertation, i.e. summarise ‘lessons from the literature’. 

For sub-headings use something like the following: 

2.1: Historical context 
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Chapter 3: (insert chapter title) 

The third chapter will generally cover methodological issues, focusing on the method you 

employ in your dissertation. This section you should: 

 Discuss the nature of the questions you are asking and choose an appropriate 

methodological stance for answering them, it is useful to present this as a 

conceptual framework 

 Describe, explain and justify the research methods you are using; this should build 

on the findings from your literature review 

 Describe and justify your evidence; where appropriate this should include 

population of interest, sampling method, details of your research instruments (e.g. 

survey questions), measurement, etc. 

 Describe the practical and technical aspects of conducting the research, where 

appropriate this should include descriptions of tests for validity and reliability 

 Discuss any ethical issues connected with the project 

It is helpful to conclude the chapter by explaining how the chosen methodology will help 

answer your research question 
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Chapter 4: (insert chapter title) 

The next chapter will typically report on the analysis of findings and research results.  In 

this section you should: 

 Describe what you found and what it means – it is important that you provide 

adequate detail on the data / information that you have collected. 

 It is also important that you provide adequate detail on how you have analysed this 

data / information.  It is helpful to organise this by theme or research question. 

 Figures and tables should be used to summarise the results where suitable.  

Where appropriate, highlight statistically significant results  

 Tie the findings back to the literature review and your conceptual framework.  Use 

the literature to interrogate and evaluate your research material and vice versa. 

 Results and findings should be compared with the hypotheses or expectations held 

before the study.  

It is useful to conclude the chapter with a summary of key findings and the relevance of 

these findings; for example, you could highlight results that are statistically robust, 

relationships that are unexpected, areas that should receive priority, etc. 
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Chapter 5: (insert chapter title) 

After the analysis you should conclude the dissertation and present recommendations.  

In thus section you should: 

 Summarise the main argument of your dissertation 

 Either discuss the validity and reliability of the findings and arguments or 

reflectively critique the account provided in your dissertation. 

 Discuss your results in the context of the UAE 

 Frame the conclusions and recommendations if appropriate.  

 Discuss the implications of your research in the area of study (on the population, 

the sector, the context) 

It is important that all conclusions are clearly linked to the objectives or research questions 

and ultimately the study aim.  It is a good practice to present conclusions under the 

subheadings of the objectives or research questions and the aim to make sure that all the 

relevant research issues are covered. 

Conclusions to your dissertation will normally be supported by recommendations on ways 

of improving or enhancing the policy or procedure under investigation.  Conclusions 

should always be related to content presented in the main body of the text (plus 

appendices), so you should not introduce new material.  It is good practice to identify in 

the conclusions the location of the evidence to which you are referring, by including a 

reference to the appropriate page or appendix.   

A good dissertation will also incorporate a reflections section in the final chapter.  Post-

graduate students should demonstrate their reflective ability at every stage of their 

academic journey.  In the dissertation the reflection is an evaluation of the process you 

undertook to complete the dissertation.  It is an examination of what worked well and what 

you could have done differently.  What lessons and skills have you learned which you can 

transfer to other areas of your practice? 
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Reference List 

Whenever you use the words, concepts or ideas of another person, you must give full 

credit to them, by means of a formal reference.  This needs to be done within the text of 

your dissertation and in a list of references/bibliography at the end.  We expect a 

completed dissertation to comprehensively cite the works of others, including both 

quotations and paraphrases from relevant sources.  The use of a wide range references 

is a positive feature of a good dissertation; marks are given for correct citation and 

referencing.  

The word count of your dissertation does not include the bibliography or references in the 

text, as usually practiced in the Harvard style referencing.  Reference management 

systems like Endnotes1 or Mendeley2 to organize and automatically generate your 

reference list.  Below is a sample Reference List. Note: your reference list should be in 

alphabetical order by Author (family name followed by initials of forename) the references 

can be single spaced as illustrated, book and journal titles should be clearly identified, do 

not use all upper case, use only the primary web address: 
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Hewison, A. (2008). Evidence-Based Policy Implications for Nursing and Policy 

Involvement. Policy, Politics, & Nursing Practice, 9(4), 288-298. 
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8 
 

Appendices 

Appendices are not counted as part of the MBRSG word limit for the dissertation (15,000 

words), but they must not exceed 25 percent of the text.  Material for appendices, (e.g. 

organisation charts, copies of questionnaires, policy documents for particular entity, 

ethics approval) should be letter referenced in the text. 

It is also helpful if the appendices section is preceded by a separate contents page e.g. 

Appendix A: Survey Questionnaire  

Appendix B: Performance Report   

Use the Harvard referencing format to refer readers to the relevant appendix which 

supports your statement in the body of the report.  This List of Appendices can be 

incorporated in the Table of Contents, appear at the beginning of this section or after the 

List of Figures and Tables at the front end of the dissertation. 
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Using this Template 

This document has been created as a customized template for the MBRSG dissertation.  

The purpose of a template is to store styles for documents and it will save you a lot of 

time when it comes to formatting the final document.  Save this document as a template 

(*.dotx) on your computer. 

When you first start your research project you can access the custom template by opening 

word, use the New option (on the File tab). Word displays two template categories: 

Featured and Personal. To choose the MBRSG template, click the Personal tab and then 

click the name of the file (Dissertation template_english). Word will then open a new 

document based on the specified template; all the styles in the template are subsequently 

available in the new document (these all have the suffix MBRSG*). 

Remember to save your work as the basic Word document (*.doc) for editing, sharing, 

printing and more.  


